Warranty

The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is delivered and licensed as “Commercial computer software” as defined in DFAR 252.227-7014 (June 1995), or as a “commercial item” as defined in FAR 2.101(a) or as “Restricted computer software” as defined in FAR 52.227-19 (June 1987) or any equivalent agency regulation or contract clause. Use, duplication or disclosure of Software is subject to Agilent Technologies’ standard commercial license terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015(b)(2) (November 1995), as applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.
# Contents

1. **Introduction** 7

   Supported Operating Systems 8
   Supported Instruments 8

2. **MicroLab Mobile** 9

   Connecting the PDA to the instrument for Communication 9
   Logging on for the first time 10
   Managing users 12
   - Adding 12
   Common icons 14
   Home screen 15
   - Status 15
   - Start 15
   - Method 15
   - Reference Method 16
   - Log Off 16
   - Lock 16
   - Menu 16
   Method screen 17
   - Methods list 18
   - Activate 18
   - Editing 18

3. **MicroLab PC** 19

   Home screen 19
   - Status 19
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logoff</td>
<td>19</td>
</tr>
<tr>
<td>Lock</td>
<td>19</td>
</tr>
<tr>
<td>Previous Results</td>
<td>20</td>
</tr>
<tr>
<td>Advanced Features</td>
<td>20</td>
</tr>
<tr>
<td>Methods</td>
<td>20</td>
</tr>
<tr>
<td>Editing</td>
<td>21</td>
</tr>
<tr>
<td>Multivariate method transfer from GRAMS PLS/IQ to MicroLab PC</td>
<td>28</td>
</tr>
<tr>
<td>Exporting the PLS/IQ *.CAL file to ASCII</td>
<td>28</td>
</tr>
<tr>
<td>Generating the method file</td>
<td>29</td>
</tr>
<tr>
<td>Using Pre-Sample Alignment Check</td>
<td>30</td>
</tr>
<tr>
<td>Transferring edited methods to MicroLab Mobile</td>
<td>32</td>
</tr>
<tr>
<td>Using MicroLab Lite Synchronize</td>
<td>32</td>
</tr>
<tr>
<td>Copying via My Computer</td>
<td>33</td>
</tr>
<tr>
<td>Moving files in a 21 CFR 11 enabled environment</td>
<td>33</td>
</tr>
</tbody>
</table>

### 4. MicroLab Quant

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home screen</td>
<td>35</td>
</tr>
<tr>
<td>Logoff</td>
<td>36</td>
</tr>
<tr>
<td>Lock</td>
<td>36</td>
</tr>
<tr>
<td>Start New Model</td>
<td>36</td>
</tr>
<tr>
<td>21 CFR 11 Features</td>
<td>41</td>
</tr>
</tbody>
</table>

### 5. MicroLab with 21 CFR 11

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCM</td>
<td>43</td>
</tr>
<tr>
<td>SDA</td>
<td>44</td>
</tr>
<tr>
<td>21 CFR 11 Software Components in MicroLab</td>
<td>45</td>
</tr>
<tr>
<td>Lock</td>
<td>45</td>
</tr>
<tr>
<td>E-sign</td>
<td>46</td>
</tr>
<tr>
<td>Reason for Change</td>
<td>47</td>
</tr>
</tbody>
</table>
## Contents

21 CFR part 11  47

6. **Measuring Samples**  49
   - Cleaning the sample interface  49
   - Collecting a background measurement  50
   - Collecting the sample measurement  50

7. **Reviewing Results**  53
   - MicroLab Mobile  53
     - Results screen  53
     - Handling data  54
     - Previous results  56
   - MicroLab PC/MicroLab Lite  57
     - Results screen  58
     - Importing spectra into GRAMS  61
   - MicroLab Report Creation  62
     - Assigning a report Template to a Method  62
     - Creating a new Report Template  63

8. **Updates and Troubleshooting**  67
   - Firmware update  67
   - Troubleshooting  67
This page is intentionally left blank.
1. Introduction

The Agilent MicroLab software suite is designed to run Agilent 4100 ExoScan, 4200 FlexScan, 4300 Handheld FTIR, 4500 Series, 5500 Series and Cary 630 FTIR spectrometers. The software comes in four modules:

- MicroLab PC
- MicroLab Mobile
- MicroLab Lite for data review and method development
- MicroLab Quant for quantitative method development
- MicroLab 21 CFR 11

The software packages provide similar functionality and structure, with the following exceptions:

- Methods cannot be edited on the MicroLab Mobile software
- Data cannot be collected on the MicroLab Lite software
- An instrument must be connected to run the MicroLab PC and MicroLab Mobile software

The software is designed to be easy to use for both advanced and novice users, with menu-driven screens and instructions to walk users through analyses.

The software incorporates a user logon; each user has defined ‘roles’ that are assigned by the administrator. These roles enable administrators to limit the methods and actions allowed for lower level users.
Supported Operating Systems

The computer must have at least a Pentium IV 3 GHz processor with 4 GB of memory, and at least 250 GB hard disk capacity. You can provide your own computer, or order an optional laptop/desktop from Agilent when placing your order.

- The MicroLab PC and Lite Software can be used on the following operating systems:
  - Windows 7 Pro/Enterprise 64-bit SP1
  - Windows 10 Pro/Enterprise 64-bit
  - English, Portuguese, Japanese, and Simplified Chinese
- MicroLab Mobile requires the Windows Mobile 6.0 or higher.
- The 4300 HandHeld FTIR requires Windows CE 6 installed on the 4300 Handheld FTIR's integrated CPU.
- The 4500 Portable FTIR is supported on the Getac RX-10 tablet with English Windows 10 Pro 64-bit
- MicroLab 21 CFR Part 11 Pharma Software can only be used with the following English only operating systems:
  - Microsoft Windows 7 Pro or Enterprise 64-bit SP1
  - Microsoft Windows 10 Pro or Enterprise 64-bit operating systems.
- MicroLab 21 CFR Part 11 Pharma Software cannot be used with:
  - Microsoft Windows 7 Pro or Enterprise 32-bit SP1
  - Microsoft Windows 10 Pro or Enterprise 32-bit operating systems.
  - Operating systems other than English

Supported Instruments

This software build is suitable for use with the Agilent Cary 630, 4100 ExoScan, 4200 FlexScan, 4300 Handheld, 4500 Portable and 5500 Compact FTIR instruments.
2. MicroLab Mobile

Connecting the PDA to the instrument for Communication
Logging on for the first time 10
Managing users 12
Common icons 14
Home screen 15
Method screen 17

To install or upgrade your software, see the MicroLab software installation instructions provided with the software.

Connecting the PDA to the instrument for Communication

1. To configure the Bluetooth connection between the Exoscan and the PDA, click on the Bluetooth icon from the home page. If “flight mode” is enabled, disable it. Click on the Bluetooth bar to turn the Bluetooth Communication on if it is not already in the “ON” mode.

2. From the Menu, choose Bluetooth Settings.

3. In the Devices tab, clear any devices by selecting the device with the Stylus and holding it in place until the menu appears. Then click Delete.

4. Once the devices are cleared, click on Add a New Device. Wait for the list of Bluetooth enabled devices to appear and select the appropriate device. Click Next at the bottom of the screen.

5. The connection with the handheld devices requires a universal passcode. The passcode required is 7890. Enter this value and select Next. The system will then test the connection to the portable FTIR Device, and add the device.
6 Once the device is added, select **Advanced** and ensure that the Serial Port configuration box is checked. The box defaults to unchecked, and must be turned on in order for the device to work properly. Click **Save**.

- The advanced option only appears right after the connection. If it disappears and returns to the device tab, select the device just connected by clicking on it with the stylus. This will bring you to the Advanced Portion above for the serial port communication setting.

7 Once the serial port has been set, select the **COM Ports** tab at the bottom of the Bluetooth settings screen.

8 Select **New Outgoing Port**. Select the device just added to the Bluetooth communication configuration and click Next.

9 The default COM Port for version 4.0 and later of MicroLab Mobile is COM 1. Set the COM Port to COM 1 and UNCHECK the **Secure Connection** box. Once you have done this, select finish in the bottom section of the screen.

- If there is a communication issue with the COM Port selected, the PDA will alert you via an error message. The COM Port default for communication can be changed via communication file for the portable/handheld device. Please contact your Agilent support personnel if additional installation instructions are needed to change the COM Port settings.

10 This will bring you back to the initial Bluetooth setting Configuration screen. Click **OK** in the upright corner and close any programs open until you return to the main home screen.

11 Choose the Start Menu and MicroLab Mobile should appear as a selection.

---

**Logging on for the first time**

**To log on to MicroLab Mobile for the first time:**
Handheld and embedded PCs shipped with the Agilent 4100 ExoScan FTIR and Agilent 4500 Series FTIR systems are supplied with a shortcut to the MicroLab Mobile software installed in the Start menu. To start the software, click **Start** then click the **MicroLab Mobile** icon. The software can also be started by browsing to My Device\Program Files\MicroLab Mobile and clicking the **MicroLabMobileEX.exe** icon or selecting Programs from the start menu and selecting the appropriate icon there. The Agilent 4300 Handheld FTIR is shipped with MicroLab Mobile preloaded in the embedded computer. MicroLab Mobile will automatically start when the 4300 Handheld FTIR is turned on.

The software will launch and display a message indicating that an initial synchronization is required. This synchronization will upload the profiles created in SCM (for 21 CFR 11 enabled software) and all methods in the Public Mobile Methods folder to the PDA or embedded computer. See Page 33 for information on moving files in a 21 CFR 11 environment.

Open MicroLab Lite on the PC and log in.

Connect the communications cable from the PDA or embedded computer to the PC.

If the synchronization is not triggered automatically, click **Advanced Features** and then **Synchronize**.

Click **New**.

Click **Get Connected Device Name**. The device name will appear in the field.

Click **Browse** and then navigate to the Public Mobile Results folder. All data collected will be saved to this folder.

Click **OK**.

Click **Sync** and then **Yes** on the displayed message to begin synchronization.

Click **OK** once the synchronization is complete.

On the PDA or embedded computer, re-launch MicroLab Mobile and then log in when the Security screen is displayed. You will use the same log in credentials that were created using MicroLab Lite or PC. The system should then display the Home Screen.
For 21 CFR 11 environments: Login with a profile that has the MicroLab Mobile privilege. Enter the appropriate user name for the profile created in SCM. The Groups and Projects fields will populate automatically. Enter the password and then click Login.

NOTE
Both the user name and password are case-sensitive.

When MicroLab Mobile 21 CFR 11 is used, passwords must be alpha numeric only. Do not use special characters such as $, @, and so on.

It is recommended to log in to either MicroLab Mobile or MicroLab Lite, but not both at the same time with the same Profile when the handheld device is connected to the PC.

Managing users

The Advanced Features option enables an administrator to manage authorized users and alter the MicroLab system features. The system is installed with multiple user levels: Admin, Developer, Technician, E-signer and Service. Additional users can be added at any time. It is advisable to set up the system with the desired users and passwords on initial launch if multiple operators will be using the system.

NOTE
Only users with administration privileges can access User Management.

This feature is not available when the 21 CFR 11 environment is enabled. All user management functions are performed in the Spectroscopy Configuration Manager (SCM) software. For more information see the SCM User’s Guide provided with the software.

Adding

To add a user to the system:

1. Tap the Advanced Features button on the MicroLab Mobile Home screen.
2. Click User Management.
3 Click **Add New User**.
4 Enter a personalized UserID in the text box.
5 Enter the user’s complete name.
6 Insert a new password.
7 Identify the role of the new user (Admin, Service, Developer, and Technician).
8 Click **Apply Changes**.
9 A window will appear notifying you that you will be logged off the system. You will be forced to login again after the changes have been applied.

**NOTE**
The system will automatically log off the user. The new UserID will appear in the User Name drop-down menu on the Logon screen.

---

**Role definitions**

**Service:** The Service role provides access to all instrument parameters within a method including the sampling technology applicable for the method.

**Admin:** The Admin (administration) role is reserved for the person(s) responsible for continual maintenance and changes to MicroLab software, including editing methods, creating new methods, defining public methods, conducting instrument verification, and controlling user access.

**Developer:** The Developer role allows access to system performance validation in addition the ability to edit and run methods. However, this role does not have access to User Management functions or system diagnostics.

**Technician:** The Technician role is for standard users of the system. The technician only has access to run methods defined by Admin as public. In addition, the technician cannot review data, conduct system validation or modify methods.
E-Sign: Designation used to allow users to e-sign methods and results at various levels of data acquisition and data review. This level is typically only used in the 21 CFR 11 version of the MicroLab Software.

**NOTE**

Only the Admin and Developer roles have access to Advanced Features.

---

**User Management screen**

**Add New User:** Adds a user to the system. A user name, password, and access level must be assigned. The full name is also required.

**Delete User:** Permanently deletes a user’s profile from the MicroLab Mobile system.

**Reset Password:** Enables the administrator to change the password of the currently selected user.

**Reset Security:** Deletes all customized users and resets the three predefined users (Service, Admin and User). This option will also reset the security if it has been disabled with the Disable Security option.

**Disable Security:** Removes all security features. When security is disabled, no password is required and all users have administrator privileges. Security can be restored by tapping the Reset Security button and then entering the initial Admin account information.

---

**Common icons**

These icons appear throughout the software:

**Home:** Returns the software to the initial Home screen.

**Menu:** Displays menu options.

**Next:** Takes the software to the next step in the data collection process.
Home screen

The Home screen is the first displayed screen in MicroLab following logon. From the Home screen, you can start a method, measure a reference sample, open the Method Selection dialog box, open the Previous Results dialog box or open the Advanced Features dialog box. All procedures begin and end at the Home screen.

Status

In the upper right corner of the screen, a small circle appears. This circle gives a color indicating the status of the instrument connected to the MicroLab software. The circle will be green when the system is operating within the factory-defined parameters. A red or yellow light indicates a parameter outside of specification. When a red or yellow light condition cannot be resolved, contact Agilent for assistance. All parameters used to determine system readiness are listed in Advanced Features > Diagnostics. Parameters outside limits will be listed in red on the Diagnostics screen.

Just above the ready light is a battery indicator. The battery indicator shows the level of charge remaining on the instrument battery. The charge level of the battery running the handheld PC is not indicated on the MicroLab software.

Start

The Start button begins a sample measurement using the currently selected method. The currently selected method is shown in the upper left corner of the Home screen.

Method

The Method button opens the Method Selection dialog box. Users without Admin privileges can only select methods designated as Public by the administrator. See the Method Selection instructions below.
Reference Method

The Reference Method button enables the collection of a reference sample for a component method. Some component methods present concentrations as a percentage increase or decrease. For these calculations, a reference of the in specification sample is needed to calculate these starting values. Also, the Reference Method saves the spectrum of the in specification (new) material for later visual comparison.

Log Off

The Log Off button exits the current user and returns the MicroLab Mobile software to the Logon screen. From there, the Exit button can be tapped to close the software.

Lock

This is available in 21 CFR 11 environments only. Use to Lock the software to control access while unattended. See the MicroLab 21 CFR 11 section on Page 43 for more information.

Menu

The menu contains:

- Previous Results
- Advanced Features

Previous Results

Enables viewing of previously collected data. Only Service, Admin and Developer roles have access to Previous Results.

21 CFR part 11

With a Results file open, click the 21 CFR part 11 button to display an audit trail with a list of actions performed while creating or editing a model.

See the MicroLab 21 CFR 11 section on Page 43 for more information on this feature.
Advanced Features

The Advanced Features screen provides access to Diagnostics, System Check, User Management, and Library Management for Admin, Service and Developer roles.

Sampling Interface

The Advanced Features screen also allows the user to access the Sampling Interface selection for the 4100 ExoScan FTIR systems. This is important for methods that are tied directly to the sampling interface as well as to link performance specifications to the sampling device. The appropriate sampling interface must be selected for either of those to work appropriately.

Method screen

Methods define instrument collection parameters and data analysis within the MicroLab software. Methods can be defined to only collect data, collect and compare collected data to a predefined library or collect data and perform a quantitative analysis on that data. Predefined methods include data collection, qualitative library searches and quantitative methods for oil and fuel analysis on the Agilent 4500t/5500t and Cary 630 FTIR spectrometers. For questions and additional information on specifications for predefined methods, contact Agilent.

MicroLab Mobile only allows for selection of predefined methods. Editing of methods must be conducted on a separate computer operating MicroLab PC or MicroLab Lite software. To be viewable within the Method dialog box, methods developed with PC and Lite versions of the software should be transferred to the following directory on the handheld or embedded controller: @\Program Files\MicroLab Mobile\Methods.

In a 21 CFR 11 environment, method transfer occurs during synchronization.
Methods list

Displays a list of methods created for the MicroLab PC application software. To move up or down the method list, simply touch the stylus to the list and drag the list across the screen.

NOTE

A system administrator limits accessibility of methods. The system administrator must select the check boxes along the left edge of the screen; this enables operation of methods for all technician level users. For users with the Technician role, this screen will display only those methods enabled previously by a system administrator.

Activate

The Activate button selects the highlighted method and closes the screen. The software returns to the Home screen. Check to make sure the correct method is active. If the incorrect method appears, return to the Methods screen and choose an alternative method. To do this, tap the Select Methods button, highlight the desired method and tap Activate.

Editing

Method editing is not available on the MicroLab Mobile software. In order to edit a method, you must use the MicroLab Lite software installed on a separate computer. Once the method is established, it can be transferred to the handheld or embedded PC for use with MicroLab Mobile.

NOTE

The MicroLab Lite software should be installed on a computer containing Microsoft ActiveSync or Windows Mobile Device Center in order to easily transfer methods and data. This can be done by creating a profile in the Synchronization page under Advanced Features.
3. **MicroLab PC**

**Home screen**

Once logged on, you will see the MicroLab Home screen. This is the main screen for the MicroLab PC software. From here, you can access method editing and reviewing data.

**Status**

In the upper left of the screen, the Status button should be green and display READY. If the field is yellow or red, click the Diagnostics button under the Advanced Features option to identify the problem. When a red or yellow light condition cannot be resolved, contact Agilent for assistance.

**Logoff**

The Logoff screen enables different users to log on and off the system. The Exit button closes the MicroLab PC software.

**Lock**

This is available in 21 CFR 11 environments only. Use to Lock the software to control access while unattended. See the MicroLab 21 CFR 11 section on Page 43 for more information.
Previous Results

Once you have performed your analysis, you can access your previous results via the Home screen. After clicking Previous Results, a screen will appear listing the samples that have been run. The samples will be named based on the chosen naming conventions.

Advanced Features

From the Home screen, you may access libraries, user access, and the change password option. This feature enables a user to perform administrator tasks.

Methods

Methods list: Displays a list of methods created for the MicroLab PC application software.

Delete: Deletes the currently selected method; only accessible by users with Admin rights. This is not available in 21 CFR 11 environments.

Import: This is available in 21 CFR 11 environments only. Import CFR and non CFR methods. CFR methods will retain the old audit trail although all signing will be removed. Once imported, these methods can be used in a CFR environment. Imported non-CFR methods are read-only.

New: Creates a new method; only accessible by users with Admin rights.

Print: This system feature enables the user to print a copy of the selected methods.

Edit: Opens the currently selected method for editing; only accessible by users with Admin rights.

Activate: Selects the currently highlighted method as the method to be used. In order to collect data using a particular method, it must first be activated.
NOTE Only methods selected in the Public column will be viewable or selectable by non-Admin level users.

Editing

Info page

Method Name: This field specifies the method name; the method name will be displayed in the method list.

Developer: This field specifies the user who developed the method.

Comment: This field is made available to the user to input any special information concerning the method.

Type page

Method Type: Three types of methods are available in the MicroLab PC software:

- Data Collect: Only collect and display the infrared spectrum. No further analysis is performed on the collected data.

- Component: Quantitative prediction methods. An infrared spectrum is collected then a predefined quantitative prediction is made from that data. Several components can be defined, each with their own quantitative calibration.

- Qualitative Library Search: Collect an infrared spectrum and search it against a predefined spectral library. The results of this method will be the top matches to the spectral library.

Check for Clean Crystal Prior to Collecting Background: This option enables or disables the system checks of the cleanliness of the ATR crystal or sample cell prior to collecting a background. This option is recommended but not required.

Background: Two options exist for collection of the background:
New Background for Each Sample: This requires the collection of a new background spectrum for every sample. This is the recommended option, as it provides the best correction for water vapor, carbon dioxide and other atmospheric variations.

Collect Background at Time Interval: If this option is selected, samples can be collected in sequence without measuring a background spectrum in between samples.

Y-Axis Units: Specifies the Y-axis scale: Absorbance or Transmittance.

Clamp max. Y-value: This option will display and values of absorbance over the specified value as that value (clamp max y-value). This is a useful option when bands that are not used analytically may be off-scale; if this feature is selected, the off-scale bands will appear ‘flat-topped’ and not adversely affect the displayed scale.

Instrument page

Background Scan: This specifies the number of scans to be collected in the background measurement. Additional scans will produce higher signal-to-noise; however, the measurement time increases proportional to the number of scans.

Sample Scans: This specifies the number of scans to be collected in the sample measurement. As with the background measurement, additional scans increase the signal-to-noise, but also increase the amount of time. The sample scans should be equal or less than the number of background scans. Typically, the background and sample are collected with the same number of scans.

Resolution: This specifies the spectral resolution. For condensed phase samples, most measurements can be made with 8 cm⁻¹ resolution.
Components page (Component Methods)

The Components page lists components defined for that method. Components are quantitative calibrations for constituents of a sample. Multiple components can be defined for each method. Next to each component is a check box in the Display column. Unselected components will not be displayed in the final results screen or reports generated from that screen.

**Add:** This button adds a component to the method. This button will display the Component Definition dialog box (see below).

**Remove:** This button removes the selected component from the method.

**Edit:** This button enables editing of the parameters used for the selected component calibration. This button will display the Component Definition dialog box (see below).

Component Definition dialog box

The Component Definition dialog box enables the addition or editing of components. This dialog box provides settings for the component calibration, the display settings and the limits for that component. The component limits enable color-coded display of the component results.

**Component Name:** This specifies the name of the component that will be displayed both in the component list and the results. For clarity, the name should include the units of the result.

**Calculation Type:** This field specifies the type of calculation to be used. Calculation types include univariate (Peak Height, Peak Height with Single Baseline, Peak Height With Dual Baseline, Peak Area, Peak Area with Single Baseline, Peak Area with Dual Baseline), noise calculation (RMS Noise), peak position (Peak Position (Center of Gravity)) and multivariate (Quant Model). The Quant Model calculation type is also used with MicroLab Quant univariate or multivariate calibrations.
The linear fit for a univariate calibration using peak height peak area or peak ratio must be conducted in third party software (such as Microsoft Excel). The MicroLab Quant software can be used to create complete univariate calibrations without the use of third party software.

Multivariate calibrations are conducted in the Thermo Galactic PLS/IQ Plus software and exported to a text format readable by the MicroLab PC software, or Eigenvector Solo Plus Model Exporter in XML format. See instructions below for details on exporting calibrations.

**Peak 1, Peak 2:** For univariate and peak position calculations, these define the peak to be used. For a peak height calculation, the largest value between this region will be selected. For a peak area, these are the limits of the area calculation. For a center of gravity, these are the limits between which the center of gravity will be calculated. For a multivariate (Quant), this will be the limit of the display range.

**Baseline 1 Start, Baseline 1 Stop:** These points define the area from which the first point of a baseline will be calculated. For a single point baseline, only Baseline 1 will be used. The baseline will be taken as the minimum value within this range.

**Baseline 2 Start, Baseline 2 Stop:** These points define the area from which the second point of a baseline will be calculated. The baseline will be taken as the minimum value within this range.

**Scaling:** This section defines a linear calibration to be applied to the data. This can be used with any of the peak definitions (Peak Height, Peak Area, and so on), or to modify the value generated by a multivariate (Quant) method. Often, this is used to change the value to an appropriate scale.

**Scale (x value):** The Scale is the slope of a linear calibration equation. In the equation for a linear fit, y=mx+b, scale is ‘m’.

**Offset:** The Offset is the Y-axis offset for a linear calibration. In the equation for a linear fit, y=mx+b, offset is ‘b’.
**Decimal Digits to Report**: This defines the number of decimal places that will be reported in the answer.

**Thresholds**: This section defines limits that the MicroLab PC software will use to color-code the displayed results and reports. Values that are between the Marginal High and Critical High, or the Marginal Low and Critical Low thresholds, will be displayed in yellow. Values above the Marginal High or below the Marginal Low thresholds will be displayed in red. All other values will be displayed in green.

**Report Value As**: Values can be reported as either the actual value or a percentage of either the Critical High or Critical Low values.

**Component Reporting page**

Component Reporting enables the method developer to determine when a component is shown in both the Results screen and the report. Only selected components that are selected in the Display column will be shown on the screen and the report.

**Edit Component Reporting Condition dialog box**

Additionally, the method developer can choose to report a component only under certain conditions. For instance, the developer can specify that a component is reported only when its value is within the range for which it has been calibrated. This enables calibrations over several ranges (high, medium and low) to be present in a method. If specified, the software will only report the concentration from the calibration that is in range. For multivariate methods, any of the method statistical measurements (Mahalanobis Distance, F-test, and so on) can be used to determine if a value should be reported.

**Report As**: This section enables the developer to choose if the component is reported as the calculated value or as a text string based on that value. Used with the Boolean logic in the condition setting, this allows text-based results, such as ‘out of specification’ or ‘good’, to be displayed instead of numeric results.

**Component/Diagnostic**: This drop-down list shows all of the diagnostic information that can be used to make a display logic choice.
**Test State:** Enables specification of the state of the diagnostic. This is used with ‘Value’ below.

**Value:** The value of the diagnostic that is used with the test state in order to determine if the component will be displayed.

**Example 1:** For a simple univariate method, two components may be specified for a single analyte; one component would have a valid calibration over a low range and the other would have a valid calibration over a high range. The developer may prefer that only the appropriate range be reported. In this example, the component will be called ‘area’ and the high range will be valid from 1000 to 5000 ppm. For this example, Area will be selected for the Component/diagnostic. First, the Test State of >= will be selected, along with a value of 1000. After this is Added, the “And” qualifier will be selected. Then the Test State of < will be selected with a value of 5000. In this example, the area component will now only be reported if the value is between 1000 and 5000.

**Example 2:** For a multivariate (PLS) method, one may have several components specified. Each component may have a different multivariate calibration. You may only want the component that has a calibration set that is most closely related to the unknown sample. In this case, the developer would select the component/diagnostic to be MDistance (Mahalanobis Distance), the test state to be <= and the value to be 3. This would only report values that have a Mahalanobis Distance less than three, which indicates that the sample is statistically within the group of the calibration set.

**Custom Fields page**

Custom fields are available and can be added or deleted by the administrator. These fields will be visible on the Results screen and the report.
Reports page

Available Report Templates: Report templates are defined for specific types of methods. Component methods can use the Oil Report. Qualitative search methods can use the Spectrum with Parameter, Stacked Spectra with Search Results, Stacked Spectrum with Subtraction and Parameters Summary or the Stacked Spectrum with Zoomed Overlay templates. Multiple templates can be selected.

Generation of New Report Templates is covered under Section 6.

Results Folder: This specifies the location within one of the following folders where the results will be saved.

- For all systems, beginning with Version 5.3, all user definable and interactive call files are kept in C:\Users\Public\Documents\Agilent\MicroLab

If this is left blank, the files are saved directly into the Results folder.

For 21 CFR 11, when left blank the default results folder is VAIMDB_Public(000)|Public Results

A different folder can be entered for saving the files within the Results directory. If the method is transferred to a system running MicroLab Mobile, the folder will automatically update to the appropriate folder on the mobile device. There is also an option for an auto-report feature. Check this box to automatically generate any and all reports associated with the method in question when a sample is collected using it.

Results Naming: MicroLab has an auto save feature that creates unique identification numbers that are exclusive to each analysis. All files are available to all authorized users and can be reviewed under the Previous Results button. An administrator has an option of choosing a format that best fits their needs.

- Sample ID + increment (Sample ID): The results name will correspond with Sample ID and time of analysis.
- Date Time: The results name will correspond with a date and time stamp of the analysis.
- Sample ID + Date Time: The results name will contain the sample ID, date, and time of the analysis.
Results Auto-Export: MicroLab has an auto-export function that allows the user to automatically export the results file at the time of data acquisition. MicroLab can generate SPC and ASP file types for importing into a variety of third party software programs. SPC is a universal spectra data file required for data use in GRAMS or in Eigenvector. ASP file formats are simply an ASCII output of the Y data.

NOTE

The Sample ID is entered by the user during analysis. If the user fails to enter a Sample ID, the system will automatically create a date and time stamp. The user must always update the Sample ID when running multiple samples. MicroLab PC will store the previously entered sample ID.

Recommend page

The recommendations will be displayed on the Results screen following sample analysis. The messages are a unique feature; they give the user the ability to customize results to their specific needs and parameters.

Multivariate method transfer from GRAMS PLS/IQ to MicroLab PC

Exporting the PLS/IQ *.CAL file to ASCII

To export the PLS/IQ *.CAL file to ASCII:

1. Generate a PLS/IQ *.CAL file using the PLS/IQ module. To save a calibration in PLS/IQ, use the procedure ‘Galactic GRAMS: Saving a Calibration from the Experiment’ from the GRAMS Help File. For questions and additional information on the GRAMS Help File, contact Agilent.

2. From the main GRAMS screen, click Add-ons > PLS/IQ > Export Calibration. An ‘Open’ dialog box will be displayed.

3. Choose the appropriate *.CAL file and click Open. An Export dialog box will be displayed.

4. The first section lists the selected calibration file. The second section lists the exported file type; the output file type should be ASCII Text.
5 Click **Next**. A ‘Save As’ dialog box will be displayed.

6 Browse to C:\Users\Public\Documents\Agilent\MicroLab\models before saving the file.

7 Enter an appropriate name and click **Open**. The calibration file will be exported. The software returns to the Export dialog box.

8 Click **Cancel** to return to GRAMS.

**Generating the method file**

**To generate the method file in MicroLab PC:**

1 From the MicroLab PC Component Definition dialog box, enter a component name. The component name is the text that will appear next to the value when the method is run by the end user. The name should be descriptive of the property being predicted.

2 For a multivariate (PLS) method, choose **Quant Model** as the Calculation Type. An Open file dialog box will appear.

3 Choose the appropriate calibration text file (exported from Galactic GRAMS in Step 7 of ‘Exporting the PLS/IQ *.CAL file to ASCII’) and click **Open**.

**NOTE**
For MicroLab Quant files the file type *.mqm, It is used in the same manner as the Grams *.cal file.

4 Other options available in the Component dialog box are listed below:

   a **Peak 1 and Peak 2:** These set a frequency range to be displayed when the component is selected from the Results screen. If this is left blank, the entire spectrum is displayed.

   b **Scaling:** The scaling section will apply a linear scaling to the result generated from the Quant model.
c **Thresholds:** These values set the display colors for the component result. If the component value is above or below the critical values, the result will be displayed in red. If the component value is between the critical and the marginal values, the result will be displayed in yellow. Otherwise the result will be displayed in green.

d **Report Value As:** Changes the display between an actual component value, a % of the critical high value or a % of the critical low value.

5 Once all of the values are set appropriately, click **OK**.

6 Click **Save As.** Enter the appropriate method name and save to C:\Users\Public\Documents\Agilent\MicroLab\Methods

- In 21 CFR 11, you will be prompted where to save the method in the database.

7 The method is now available for use with MicroLab PC. Ensure that the method is activated in order to use the method.

**Using Pre-Sample Alignment Check**

The Pre-Sample Alignment Check produces a visual indication of the signal strength from a measured sample in a preview screen. This allows you to determine if the sample is at the instrument focus or flat against the ATR crystal or reflectance housing, or that the instrument is aligned to the sample for maximum signal. This procedure details creation of a method that uses the pre-sample alignment check. In the method, a measurement to be made from the sample will be specified. Typically this should be a peak height or area that corresponds to the sample of interest.

**To check the sample alignment:**

1 From MicroLab PC or MicroLab Lite, click the **Method** button.

2 In the Method dialog box, click the **New** button.

3 On the first page of the Method Definition dialog box, choose **Components** from the Method Type drop-down list.

4 Click the **Component** tab.

5 On the Component page, click the **Add** button.
6 In the Add Components dialog box, specify a Name for the component.

7 Select a Calculation Type for the component. Typically, either a Peak Area With Dual Baseline or a Peak Height With Dual Baseline will give the best indication of sample alignment.

8 Define the peak (area) to be measured. For peak areas, Peak 1 and Peak 2 define the edges of the peak. For Baseline 1 and Baseline 2, baseline is established as the lowest point between the Start and Stop points.

9 Set a Scale Factor such that the measured points will be greater than 1. For peak heights, a scale factor of 1000 ensures that most measurements are on-scale.

10 Click OK.

11 On the method Type page, select Show Pre-Sample Alignment Check. From the drop-down list, choose the component defined in Step 6.

12 It should also be noted that the Sample Continuity Check can be used to ensure that the system is aligned to the sample throughout the measurement.

13 Click Save As and save the method.

14 For use on the handheld PC, the method should be transferred to the MicroLab Mobile/Methods folder on the mobile device.

15 In MicroLab Mobile, the Pre-Sample Alignment Check will be displayed as a red/yellow/green bar graph on the Sample Alignment page. The sample should be rotated or aligned in order to reach the maximum value on the bar graph.
Transferring edited methods to MicroLab Mobile

After completing modifications to a method in MicroLab PC or MicroLab Lite, the files should be transferred to the embedded or handheld PC for use. There are two ways to copy files; by using My Computer, or by transferring them automatically via MicroLab Lite.

Using MicroLab Lite Synchronize

To transfer methods to MicroLab Mobile using MicroLab Lite Synchronize:

1. Connect the handheld or embedded PC to the computer containing MicroLab PC and start ActiveSync as specified in ‘Initial Setup’ Steps 1 and 2 on Page 10. For a 4300 Handheld FTIR, exit the Microlab Mobile software on the device and connect to the computer using the USB connection.
2. Open MicroLab Lite on the computer.
3. Click Advanced Features.
4. Click Synchronize.
5. If no connection is listed, click New.
6. In the dialog box, select Get Connected Device Name; the serial number of the connected PDA or 4300 Handheld FTIR instrument will be entered in the dialog box automatically.
7. For standard configurations, select what options are to be synchronized. Reports, Results and Methods can be synchronized. In addition, reports can be automatically printed by specifying the desired printer. For 21 CFR 11 enabled systems, click Browse and then navigate to the Public Mobile Methods or Results folder. To upload method files to MicroLab Mobile with 21 CFR 11 enabled, the files must be located in the Public Mobile Methods folder. All method files in that folder are uploaded.
8. Once the device to be synchronized has been selected, click OK.
9. To transfer files, highlight the desired handheld PC from the list and click Synchronize or Sync and then click Yes.
Copying via My Computer

For 21 CFR 11 environments, non-CFR methods are visible in the mobile environment when copying via ‘My Computer’, but cannot be activated.

To transfer methods to MicroLab Mobile using My Computer:

1. Connect the handheld or embedded PC to the computer containing MicroLab PC and start ActiveSync as specified in ‘Initial Setup’ Steps 1 and 2 on Page 10. Note, this procedure will not work on the 4300 Handheld FTIR. Use the Synchronize feature as specified on Page 32.

2. From the computer, open **My Computer** and browse to C:\Users\Public\Documents\Agilent\MicroLab\Methods

3. Select the desired methods and choose Edit > Copy.

4. From the My Computer heading, select the **Mobile Device** drive.

5. Browse to the folder Program Files\MicroLab Mobile\Methods\.

6. Click Edit > Paste.

7. Return to the C:\ drive on the computer and browse to C:\Users\Public\Documents\Agilent\MicroLab\Models

8. Copy the entire contents of the Models folder.

9. From the My Computer heading, select the **Mobile Device** drive.

10. Browse to the folder Program Files\MicroLab Mobile\Models and click Edit > Paste.

11. Click Yes to All if an overwrite warning appears.

Moving files in a 21 CFR 11 enabled environment

This procedure can be used for method or results files.

To move files from one folder to another:

1. Logged on user must have ‘Cut/paste method/results’ privilege.

2. In MicrolabLite or MicrolabPC, select the desired files, right-click and then select ‘Cut’.

3. Navigate to the appropriate folder and then ‘Paste’ the files.

Files cannot be copied to different folders.
This page is intentionally left blank.
4. MicroLab Quant

Home screen  
Logoff  
Lock  
Start New Model  
21 CFR 11 Features  

Home screen

When MicroLab PC v 5.1 and higher is installed, the MicroLab Quant Module will also install. The module is designed to allow the user to create methods and models that are to be used in the MicroLab Component methods module of MicroLab PC.

MicroLab Quant uses the same security settings and user administration tools that are applied in MicroLab PC. To log in, the user enters their username and password as if they are entering Microlab PC. For 21 CFR 11 environments, the group and project must also be entered.

The following options are available:

- Start New Model
- Previous Project/Model
- Evaluate Model
- Import Models (available with 21 CFR 11 only)

Data for the new project/model should be collected prior to using Quant. This should be done in MicroLab PC. All data should have been collected using the same data collect parameters.
Logoff

The Logoff screen enables different users to log on and off the system. The Exit button closes the MicroLab PC software.

Lock

This is available in 21 CFR 11 environments only. Use to Lock the software to control access while unattended. See the MicroLab 21 CFR 11 section on Page 43 for more information.

Start New Model

To generate a new Model

1 Select the Start New Model. The software will auto-generate a name for the new project, however, the user has the opportunity to create and enter a name as well.

2 The data selection menu appears and allows the user to select the folder where the data is currently stored. The data is also then grouped by the method with which it was acquired.
   a Select the data required to be used for the model generation. This can be done by clicking on the data. The user can use the CTRL and Shift keys to highlight multiple files, similar to file selection in a windows environment.
   b Once the files have been selected, click on the [Next>>] button at the bottom of the screen to proceed.

3 For each standard enter the concentration in the concentration column.

4 Select the type of algorithm that should be applied to the data and then click [Next>>]. This is located at the top software screen and is indicated as [Quant Algorithm].
a **Simple Beer’s Law:** Typically characterized as a linear equation of a single component. The component is defined by a series of known concentrations and the change in a specific spectral characteristic that is shown in Absorbance units. These changes can be peak heights, areas or ratios. A linear equation is then determined in the form of \[ y = mx + b \] from the Beer’s Law construct of \[ A = ebc \]. This is what is then used to determine unknown concentrations versus the known calibration equation.

b **Classical Least Squares:** Used when multiple components are present within a mixture. This analysis type is also based on Beer’s Law where multiple frequencies are chosen to capture all of the changes happening to all components. Each of these is used in combination to determine the best correlation of predicted versus actual concentration for the calibration model.

   1. Multiple frequencies are defined and unlimited. Known concentrations of each constituent should be defined.
   2. CLS is not useful for mixtures that have matrix effects on components that interact with one another. It can also be susceptible to baseline effects.
   3. CLS is most effective for identifying one component in a mixture.

c **Inverse Least Squares (Also known as Inverse Beer’s Law, or Multiple Linear Regression):** Used in multi-component mixtures where matrix effects are present. This analysis type is based on Beer’s Law. Multiple frequencies are used to define the calibration of \[ C = P*A + e \], an inverse of Beer’s Law.

   1. Best used as a Multivariate model where only knowledge of the constituent of interest is required. Suited to complex types of analysis.
   2. The number of frequencies used in the calibration cannot be greater than the number of known standards used in the calibration. These frequencies should correspond to changes in the constituent of interest.
   3. ILS generally produces the most accurate calibration if a sufficient number of calibration spectra are available.
Once the quant algorithm has been selected, peak definition is required. The software allows for the selection of peak heights and peak heights, areas, and ratios.

a **Peak Height Definition:** Drag and drop the Peak Height Icon on the spectra displayed in the data window [ ]. The arrows on the Spectral Display allow the user to interactively change the baseline and peak position.

1 **Red Arrows** pointing in the upwards direction define baseline positioning – start and end points.

2 **Blue arrows** pointing in the downwards direction indicate the peak position.

b **Peak Area Definition:** Drag and drop the Peak Area Icon on the spectra displayed in the data window [ ]. The arrows on the Spectral Display allow the user to interactively change the baseline and peak position.

1 **Red Arrows** pointing in the upwards direction define baseline positioning – start and end points.

2 **Blue arrows** pointing in the downwards direction indicate the peak positioning – start and end points.

c **Peak Ratio Definition:** the software allows for a peak or area ratio to be used for calibration purposes. It requires that a minimum of two peaks be defined, either by area or height. Once the peaks of interest are defined, click on the Peak ratio Icon below the data window [ ]. The dialogue will then prompt the user to define the numerator and denominator for the ratio equation.

d **Scaling:** The user is allowed to click and zoom on the displayed spectral data interactively. To “unzoom”, right-click in the spectral display window and click on [Full Scale]

e **Data Table:** The data shown in the table is representative of the peak definitions the user has added via the interactive spectral display window. The user may choose the change these values directly in the table if specific values are necessary.

1 **Include in Model Option:** Allows the user to decide which operations are included in the model they are developing. This is based on the full data set.
2 **Delete:** Allows the user to delete peak definition from the model permanently.

**f Standards Table:** Allows the user to interactive select which specific standards to use in the calibration algorithm. Individual Spectral data can be removed from the plot or model by de-selecting the corresponding check box. As well, an individual Spectrum can be highlighted in the display window by highlighting it in the standards window.

**g Model Plot Window:** The default of the model plot window is to display the Actual versus Predicted plot. The user can switch to the Defined Peak vs Concentration Plots in one of two ways:

1. Right-click in the model plot window and select the desired plot.
2. Click the **Select Model Plot** button on the bottom of the analysis screen.

**h Model Evaluation:** By clicking on the Model Evaluation button, the software presents the user with two functions. These functions are typically used to determine outliers and robustness of the calibration set.

1. **Cross Validation:** The software runs through the calibration eliminating each standard and then determining what value would be returned if running that standard as an unknown.

2. **Independent Set:** Allows the user to [Add Files...] of check standards that have been run independently of the calibration and predict the values on these samples. The concentrations of each sample are entered into the table and then the [Predict] button is clicked.

   a. Total Standard Error, R-Squared for Actual V Predicted are shown at the bottom of the screen. The Actual V Predicted graph is also displayed on the screen.

   b. The user can Export the values to a CSV file format in the location of their choice.
c. The user now has the option of saving [Save] the model and returning to the previous data analysis screen [Back].

i Finalize Model: If the user is satisfied with the calibration model, the [Finalize Model] button is chosen. This then allows the user save the Project (*.mpq) which includes the standard and model. The user can also choose at this time to save the data to a MicroLab method. This will include the component that the user just defined in the associated model with all of the calibration parameters.

1 Model Files: If multiple components need to be defined, then this will be done in individual models/projects. Each component is defined in an individual model or *.mqm file at the same time the project file is saved.

2 Save Method: Saves the files to an *.a2m file extension with the component of interest. The method will have the same data collect parameters as the calibration files which were used to create the model. If multiple components are necessary in a methods file, then they must be added to the method manually through MicroLab Lite or PC. See Section on Multivariate method transfer under MicroLab PC. The models are added in the same way as the GRAMS models, however, they are defined as the *mqm files as noted above.

3 Print: Select to create a PDF including the standards and model information. The file is saved in the C:\Users\Public\Documents\Agilent\MicroLab\Results folder.

6 Previous Project/Model: Allows the user to select a previous started project and edit parameters. This is done similar to the Start New Model section above. However, some amount of work has already been done. Typically standards may have already been added and some peak definition may have been added. The user can now go through the same steps, to define, evaluate and finalize their methods.
7 **Evaluate Method:** This allows the user to select a method to evaluate. The **Independent Set Evaluation** screen is shown allowing the user to proceed with loading known standards and predicting the concentration as was done previously in the model evaluation section in the New Model setup.

**21 CFR 11 Features**

See the MicroLab 21 CFR 11 section on Page 43 for more information on these features.

**21 CFR part 11**

Displays a list of actions performed while creating or editing a model.

**E-Sign**

Click E-sign to apply an electronic signature and add comments to the model.
This page is intentionally left blank.
5. MicroLab with 21 CFR 11

The 21 CFR 11 component consists of two programs:

- Spectroscopy Configuration Manager (SCM)
- Spectroscopy Database Administration (SDA)

Once measurements have occurred, you cannot delete the results.

Once CFR is installed, you cannot turn off CFR functionality. Uninstalling the MicroLab software and SCM and then reinstalling only MicroLab software retains the CFR rules. This preserves the CFR environment integrity.

For installation instructions, see the ‘MicroLab Software Installation Instructions for 21 CFR Part 11 Environments’ provided with the software.

SCM

The Spectroscopy Configuration Manager (SCM) is a software interface between system administration personnel and the Server and Acquisition Server part of Agilent spectroscopy software applications. SCM provides the means to create, configure and maintain data regarding system security, user management and data paths.
To provide the security required for compliance with the 21 CFR Part 11 rule, Agilent uses SCM for security and permission rights. These security functions provide:

- Access controls and authority checks via the use of user identification codes and passwords.
- Electronic record security via the use of databases.
- Time and date stamped audit trails.

The use of user identification codes and passwords enables control over who can log on to the system and who can perform particular functions within the Agilent application software. It also provides the mechanism to allow electronic signing of electronic records. The use of databases coupled with SCM, prevents all unauthorized users from changing or deleting files. The SCM event logs augment the audit trails resident in the application software. The SCM administrator must set up the required users. It is important that a number of simple requirements are followed when this is done to ensure that compliance with the 21 CFR Part 11 rule is maintained.

For additional information about configuring SCM see the SCM Help. To access the SCM Help, with the SCM application open, press F1 on your keyboard or navigate to C:>Program Files (x86) > Varian > 21 CFR 11 > Configuration manager > Server > Configuration Manager Database Help.

**SDA**

The Spectroscopy Database Administrator (SDA) has been designed for system administrators to set up and maintain the databases that are used by the Agilent application software to store data.

You can use SDA together with the Agilent Spectroscopy Configuration Manager (SCM), the application software, and your own Standard Operating Practices (SOPs) to form a 21 CFR Part 11 capable environment for controlling your Agilent instruments.

SDA allows the data collected by Agilent instruments to be stored locally (on the same PC as the Agilent application software), or remotely in a Client/Server arrangement.
Configuration must be performed by the system administrator, or a person with administration rights to run SDA.

For additional information about configuring SDA see the SDA Help. To access the SDA Help, with the SDA application open, press F1 on your keyboard or click Start > All Programs > Agilent > Database Utilities > SDA Help.

21 CFR 11 Software Components in MicroLab

With the 21 CFR 11 software installed, additional buttons will be available.

Lock

This dialog allows the user to lock the MicroLab software when using the 21 CFR Part 11 software package. It is accessed from the Home screen.

When locked, the Unlock MicroLab PC dialog box appears and no actions can be taken until a validated user logs on and unlocks the software. Users other than the one that ‘Locked’ the MicroLab PC/Lite/Quant/IQ/OQ originally can only unlock the software when they are on the Home page. Only the user who is originally logged on to the software can unlock the software from all pages. This ensures privileges are applied correctly, audit trail information is correct in MicroLab and Configuration Manager and results file are saved correctly.

User Identification — Type your user identification.

Group — Select your group from the drop-down list.

Project — Select your project from the drop-down list.

Password — Enter your password.

NOTE

When MicroLab Mobile 21 CFR 11 is used, passwords must be alpha numeric only. Do not use special characters such as $, @, and so on.
**OK** — Click OK to log on and exit the dialog box. The software is now unlocked.

**Cancel** — Click Cancel to exit the dialog box without logging on. The software stays locked.

**E-sign**

Click E-sign to apply an electronic signature. Any User can “Sign” the method or results. To perform Approval – 1 and Approval – 2 the User must be given appropriate permission in Spectroscopy Configuration Manager. You do not need to login to the MicroLab software to approve, however when the Signature dialog appears the User will need to enter their credentials to perform the Approval – 1 or Approval – 2. The original User who was logged in before the Approval is performed will remain logged in. If the account of the user logged in to the MicroLab software is deactivated or locked, when cancelling out of the e-Signature dialog the Lock dialog will appear. The original user account must be unlocked by the Configuration Manager Administrator before the MicroLab software can be unlocked.

**User Identification** — This field displays the name of the current user. The operator/approver must enter their user identification in this field prior to applying an electronic signature.

**Group** — The group will automatically be populated once the user identification field is entered. If the User is linked to more than one group, choose the appropriate group.

**Project** — The project will automatically be populated once the user identification field is entered. If the User is linked to more than one project, choose the appropriate project.

**Password** — The operator/approver must enter their password in this field if they are to apply an electronic signature.

**Comment** — In this field, type information about the action that is being signed off, or the meaning of the signature. It is compulsory to enter a comment – if it is left blank, when the ‘Sign', 'Approval-1' or 'Approval-2' button is clicked, a message is displayed stating that this is a required field.
Approval-1 — Click to apply an electronic signature at the Approval-1 level. A user who ran the method cannot also approve the data, a message stating this is displayed.

Approval-2 — Click to apply an electronic signature at the Approval-2 level. A user who ran the application and created the data cannot also approve the data, a message stating this is displayed.

The method or results will become locked once Approval – 2 has been performed. This method or results can be opened and viewed, but no further modifications can be performed. A new method can be created from this locked method.

MicroLab method and result files cannot be locked unless Approval-2 is performed. A company SOP may be required to ensure no further modifications are made to the file once the document has been signed by the Operator and Approver-1. Any modification between performing the e-signature are detailed in the Audit Trail including the e-signature events.

Reason for Change

This dialog box will open as soon as a change is made to the method. The method is saved immediately after the Reason for change' dialog is completed.

This dialog box enables a user to enter a reason for any changes that have been made to a method.

The information entered here will be displayed in the MicroLab report, the datalog and the Audit log in SCM.

The bottom part of the dialog box shows the log of the method including any changes that have been made.

21 CFR part 11

Click to access the Audit Trails, Collect Parameters and Analysis Parameters tabs.
Audit trail

The method and results audit trails are displayed, showing all recorded actions including:

- Method and results save location
- Method used for re-analysis
- Method parameter changes
- Reason for change
- Method run started
- Method run stopped
- Unexpected instrument failure, method run stopped
- Method or results authorized

For each entry above, a combination of the following information is also logged:

- SDAdministrator server/database/file name
- Local Date and Time
- GMT Date and Time
- Workstation name
- User: Group/Project/User ID
- Username
- User Description
- Instrument Serial Number
- Validated comment
- Software version number
- Firmware version number
6. Measuring Samples

Cleaning the sample interface 49
Collecting a background measurement 50
Collecting the sample measurement 50

The MicroLab Mobile software is designed to walk the user through sample measurement. The software displays images and instructions of the actions that are required by the user for sample measurement. Following the instructions on the screen ensures consistent measurement results. For any sample measurement, the following steps are taken:

- Clean the sample interface.
- Collect a background.
- Place the sample to be measured.
- Collect the sample measurement.

Cleaning the sample interface

The first step in making a sample measurement is to ensure that the sample mounting interface is clean of any residue from previous samples or from general use and storage. For specific instructions for cleaning, refer to the appropriate instrument operation manual supplied with the system.

CAUTION

Do not break the spectrometer seal and attempt to clean interior surfaces. Breaking the seal will void the warranty.
Measuring Samples

Collecting a background measurement

It is recommended that the system is configured to collect a background before every sample.

Before you begin an analysis, the software will automatically collect a background spectrum when the method is configured as recommended. The background measurement (with no sample present) provides a baseline profile of the current system conditions and enables you to factor out any anomalies occurring in both the background and sample spectrum.

NOTE

As mentioned above, before collecting a background, ensure that the sample interface is clean. To clean the sample interface, a suitable solvent such as methanol, acetone or isopropyl alcohol should be used. See the instrument operation manual for more detailed information.

To collect a background measurement:

1. On the Home screen, ensure that the appropriate method is active, then click **START** to initialize background sample analysis.

2. Click **Next**. A brief check of the sample interface (that is, the crystal) will occur. Following a successful test, the system gathers a ‘background’. Background progress is indicated by a status bar.

NOTE

Only click HOME to go back to the main home screen if you wish to start your analysis over.

Collecting the sample measurement

To measure a sample:

1. To begin sample measurement, click the **Start** button on the Home screen.

2. As the software instructs, clean the sample interface for an ATR or Transmission measurement. For a reflectance measurement on the Agilent 4100 ExoScan FTIR, the reflection standard should be placed on the sample interface.
NOTE
The sample surface should be cleaned with a soft tissue and an appropriate solvent such as methanol, ethanol or acetone.

3 Click the Next button. Clicking the Home button will stop the measurement and return you to the Home screen.

The Clean Crystal Check will be conducted if it has been selected in the method. This will check for absorbance over a stored reference. If any absorbances are found, the software will instruct you to clean the sample interface and start again.

NOTE
If the clean crystal check continually fails, the stored background scan may be corrupted. If this occurs, the clean background can be reset by clicking Advanced Features > Diagnostics then Reset Clean Check in the Diagnostics dialog box. This will clear the stored background.

4 Following the crystal check (if specified), the software will collect the background sample. Background samples are collected either at every scan or after a specified time interval, as specified in the method.

The software will instruct you to apply the sample to the sample interface. The picture displayed will match the configuration of the system. Once the sample is in place, click Next.

5 The software will display a graph showing the intensity (absorbance) of the sample measurement. This screen is used to ensure that the sample has been correctly placed at the sampling interface. For oil applications using the Agilent 4500t FTIR, the value should be maximized. For Agilent 4100 ExoScan FTIR applications using reflectance, the value should be between 0.1 and 2 AU; ATR measurements should be between 0.05 and 1 AU.

6 Enter a file name in the Sample ID field; this will be the file name under which the sample data is saved. Enter further information about the sample in the Comment field.

7 Click the Next button to begin sample measurement. The software will co-add sample scans as specified in the method.
During sample measurement, the sample needs to remain at the focus of the sampling technology. For the Agilent 4500t FTIR, the sample cell should not be adjusted during the measurement. For the Agilent 4100 ExoScan FTIR, the instrument should not be moved from the sample surface during the measurement. The software monitors the sample signal during measurement. If the signal falls below a preset threshold, the collection will stop. Once the sample focus is regained, the software will immediately start collecting data.

**NOTE**

The progress bar shows the advancement of the data collection. When the progress bar is complete, the prompt will change to Transferring Data. Once this occurs, the measurement is complete and the instrument can be removed from the sample.

When the sample measurement is complete, the software will display the method results in the Results screen. The sample spectrum and the calculated method results will automatically be saved. The data can be returned to at any time from the Previous Results screen.
7. **Reviewing Results**

**MicroLab Mobile**

**Results screen**

For component methods, the Results screen shows the calculated component values. Component values are ordered relative to their critical limits; those values outside of the critical range are listed first followed by values outside of the marginal range. The components within the acceptable range are shown last in green.

- Green results show that the sample is within adjustable limits.
- Yellow results show that the sample is between marginal and critical limits.
- Red results show that the sample is above or below critical limits.

**Home**: This button returns the software to the Home screen.

**Next**: This button returns the software to the Sample Collection page for measurement of additional samples.
Handling data

The Menu button enables you to choose Data Handling. This button allows the user to input a Sample ID and comments if not previously entered. The system’s auto-save feature will save the Comment field and generate a new file based on the sample ID if one is entered.

NOTE

The auto save feature will always save the current file with a sample ID and a time date stamp. This prevents the user from saving over a previous sample results.

Home: Returns the software to the Home screen.

Next: Takes the software back to the start sample screen to measure the next sample.

Re-Analyze: Enables you to perform the calculations of a different method on the currently viewed data. This is useful when it is not possible to recollect the sample data.

NOTE

The Re-analyze feature should be used only with data collected at the same spectral resolution as the method chosen. Differences in spectral resolution can quantitative results.

Export: Enables you to export collected data to other analytical software packages. The exported file will be saved with the same file name as the sample, except the extension will be *.asp or *.spc. It will be saved into the Results directory.

Peak Picking: Enables the user to define peaks to be marked on the spectrum being reviewed. This is done by right clicking on the spectrum and choosing Peak Pick from the menu. To mark peaks on the spectrum draw a threshold line by clicking, dragging, and clicking again. This can be repeated multiple times to define several peaks on the spectrum. The peaks will print on any report generated and will keep with the data file. Once done, right click again and de-select Peak Pick from the menu.
Importing spectra into GRAMS

To import data from a ‘foreign’ format to Thermo Electron SPC format:

1. Open GRAMS/AI on your computer and click File > Import/Export. Select the ASCII file converter. Then, click the Import button.

2. Browse the drives and directories to locate the file(s) you wish to import. When importing, remember that most file converters expect a particular input file name extension. For example, the ASCII converter looks for files with the *.ASP file name extension. (If needed, change Files of type to All Files (*._*).)

You may select multiple files by pressing the CONTROL key while clicking each file name.

Click Open. The File Import dialog box displays the name of the file to import. (If you are importing more than one file, the name of the first file will be displayed.)

3. Rename the file, if desired. To write the newly created file to a different directory, precede the file name with the complete directory path. Otherwise, it will be saved in the same folder as the ASP file. (You must have read/write access to the output directory.)

4. Choose an experiment key extension from the Output File Type list. Leave it set to the default Spectra (*.spc).

5. Select an Output Rename option. Leave it as Manual.

6. Click Auto-open to automatically open the converted file in GRAMS/AI. (Auto-open will not open multiple files. Auto-open will apply to the last file converted.)

7. From the File Import dialog box, click OK.

As the file is converted, GRAMS Convert Application reads in the file to import and writes a new file to disk. Once the conversion process is complete, you can load the file into GRAMS/AI using the File > Open Trace command.
Reviewing Results

As the conversion proceeds, any messages or errors are displayed. If many files are being converted, you can switch back to GRAMS/AI or any other Windows program and the conversion continues. Note that the Convert program is actually a separate application named GRAMSC32.EXE and can be independently started from Windows from GRAMS/AI. The File > Import/Export command launches this application with a special command line switch, which causes it to automatically exit after the conversion.

**Report:** Clicking the Data Handling button enables you to save a report. Reports are *.PDF files, which detail the component results for component methods or the library search results for Qualitative Search methods. The reports are saved in the Results directory and can be synchronized using MicroLab Lite.

**Previous results**

MicroLab Mobile’s Previous Results enables reviewing of data after collection has occurred. Previous results are available under the Menu icon on the Home screen. A list of previously collected samples is displayed on the Previous Results screen. In order to move through the list, click the list and drag to scroll.

**Home:** Returns the software to the Home screen.

**View:** Opens the data file for viewing. The data will be presented in an identical way to the Results screen shown in the Reviewing Results section on Page 53.

**Report:** From the Menu button, the Report button will generate a PDF report as specified in the Reports page section on Page 27.
MicroLab PC/MicroLab Lite

MicroLab PC/MicroLab Lite enable further data analysis than is available within MicroLab Mobile. Due to the screen size, spectra are not currently displayed in the MicroLab Mobile software. MicroLab PC/MicroLab Lite enable viewing of the spectra and review of the spectral regions that were used for the component calculations. Once the data has been transferred to the computer (see Transferring edited methods to MicroLab Mobile on Page 30; transferring results is analogous to transferring methods), it can be reviewed using the Previous Results feature of MicroLab PC or MicroLab Lite. From the MicroLab PC Home screen, click the Previous Results button; a screen will appear listing the all sample file names.

**Home**: Returns the software to the Home screen.

**Import**: Enables you to make additions to the Results screen.

**Report**: The ROAR Report for the sample reviewed at this point. You can print a copy of this report from this screen. A toolbar will appear that enables you to Export and Print.

**View**: Returns the software to the Sample Results screen. The Sample Results are always reviewable with the MicroLab software.

**Overlay**: The Overlay button appears when more than one spectral file is selected. It allows the user to view up to 5 sample spectra in overlaid or stacked format for comparison. The files must have the same abscissa type in order to be viewed together.

**Export**: Enables you to export collected data to other analytical software packages. The exported file will be saved with the same file name as the sample, except the extension will be *.asp or *.spc. It will be saved into the Results directory.

**Diag Info**: Displays diagnostic information for the spectrometer connected to the MicroLab software.

**NOTE**

The software from the previous results section will operate as the results section operates. The screens are identical. These features enable operators to review data.
Reviewing Results

Results screen

Results box

The results are color-coded for clarity and out-of-spec results are highlighted red and are moved to the top of the list.

- Green results show that sample is within adjustable limits.
- Yellow results or close to acceptable limits.
- Red results shows that sample are outside acceptable limits.

The Results table has two headers: Parameters and Current Level.

Viewing spectra regions

A unique feature of the MicroLab software enables you to compare samples at specific regions. Simply double-click the individual parameters. The reference spectra will appear alongside the sample spectra. Moving between categories is accomplished by using the left and right arrows in the top right corner. You may decide to compare sample and reference spectra in an Overlay or Stacked view.

Figure 1. Example of Stacked option
Figure 2. Example of Overlay option

**NOTE**

To change between categories, right-click and scroll down to either option. The screen will reflect the view you indicate.

---

**Details**

Click **Details** to view the spectrum of the sample. The MicroLab software will display the sample spectra against the reference spectra.
You can zoom in on any portion of the spectra. Using the mouse or touch pad, 
click on the graph and highlight the desired portion. The screen will automatically 
change to the zoomed in portion.

To return to the full spectrum, right-click on one graph and choose Undo Zoom.

**Data handling**

Click **Data Handling** to access the following features.

**Report:** Clicking the Data Handling Button enables you to generate a 
ROAR Report in a new window. The report outlines the preset 
parameters and shows the results in relevant units compared to the 
reference oil or ASTM method where appropriate.

**Add To a Library:** Enables you to add the sample spectra to an 
appropriate library. Click ‘Browse’ to access the library. A list will 
appear that shows the libraries available to you.

Add To Library will complete the process. Adding new spectra to the 
user’s library enables the software to determine if the subsequent 
samples are similar.

**Export:** Enables you to export collected data to other analytical 
software packages.

**Go To ResPro:** Automatically detects whether Resolutions Pro 
software is installed and allows the user to directly export the data 
displayed for advanced data processing and analysis.

**E-Sign**

This is available in 21 CFR 11 environments only. Click E-sign to 
apply an electronic signature. See Page 46 for more information.

**21 CFR part 11**

Displays a list of actions performed while running or editing a 
method or results. See Page 47 for more information.
Importing spectra into GRAMS

To import data from a ‘foreign’ format to Thermo Electron SPC format:

1. Open GRAMS/AI on your computer and click **File > Import/Export**. Select the ASCII file converter. Then, click the **Import** button.

2. Browse the drives and directories to locate the file(s) you wish to import. When importing, remember that most file converters expect a particular input file name extension. For example, the ASCII converter looks for files with the *.ASP extension. (If needed, change Files of type to All Files (*.*).)

You may select multiple files by pressing the CONTROL key while clicking each file name.

Click **Open**. The File Import dialog box displays the name of the file to import (If you are importing more than one file, the name of the first file will be displayed.)

3. Rename the file, if desired. To write the newly created file to a different directory, precede the file name with the complete directory path. Otherwise, it will be saved in the same folder as the ASP file. (You must have read/write access to the output directory.)

4. Choose an experiment key extension from the Output File Type list. Leave it set to the default **Spectra (*.spc)**.

5. Select an Output Rename option. Leave it at **Manual**.

6. Click **Auto-open** to automatically open the converted file in GRAMS/AI. (Auto-open will not open multiple files. Auto-open will apply to the last file converted.)

7. From the File Import dialog box, click **OK**.

As the file is converted, GRAMS Convert application reads in the file to import and writes a new file to disk. Once the conversion process is complete, you can load the file into GRAMS/AI using the **File > Open Trace** command.
As the conversion proceeds, any messages or errors are displayed. If many files are being converted, you can switch back to GRAMS/AI or any other Windows program and the conversion continues. Note that the Convert program is actually a separate application named GRAMSC32.EXE and can be independently started from Windows from GRAMS/AI. The File > Import/Export command launches this application with a special command line switch, which causes it to automatically exit after the conversion.

**Done:** Returns to a screen that prompts you to clean the sampling area and sampling device. This prepares the spectrometer for the next sample. ‘Done’ enables you to run multiple samples without having to return to the Home screen.

**NOTE**
This option does not allow you to change unit information. If you are running samples from different machines, you must return to the Home screen.

**NOTE**
If you would like to stop the analysis, click the HOME button.

### MicroLab Report Creation

**Assigning a report Template to a Method**

MicroLab allows the user to choose from a list of report templates and associate them with their specific methods. Each of the report templates are designated when created to a method type or specific function in the software.

**To assign a report template to a method:**

1. Select **Methods** from the **Home** screen and then select the method where a report template is desired. Select **Edit**.
2. From the method tabs, select **Reports**.
3. From the list of **Available Report Templates**, select one or more templates to associate with the method. Then click on the **Add** button.
4 If automated report generation is desired, select the check box labeled *Auto-Report All Selected Reports*. This will automatically generate all associated reports at the end of the data analysis.

5 To remove an unwanted report, simply select the unwanted report and click the **Remove** button.

6 Once all changes have been made, click the **Save** button to save the method or **Save As** to save the method as a different method name.

**Creating a new Report Template**

When MicroLab PC is installed, it will also install an add-in to Microsoft Office’s Word platform. This requires Microsoft Word 2010 or greater to work properly. The add-in allows the user to customize or create report templates for use within the MicroLab software platform.

The use of this function requires knowledge of Microsoft Word that may not be covered in this manual.

**To create a new report template:**

1. Open Microsoft Word and create a new document.
2. Once this document is created, navigate to the View menu/tab.
3. A new feature has been added to the View Menu – MicroLab Reporting. This includes two buttons: Report Designer and Perform Merge.
4. To begin creating the document, Select the Report Designer function. The schema associated with MicroLab will appear as a menu on the right of the screen.
5. Decide the type of report that is needed and select it under Report Type. Types of reports include the following:
   a. Component Report: This will only show up if the Method has been designated as a component method in the method editor.
   b. Qualitative Search: This report template will only show up if the method has been designated as a qualitative search method in the method editor.
Reviewing Results

c  Data Collect Only: This report template will only show up if the method has been designated as a Data Collect method in the method editor.


6  Give the Report Template a name in the MicroLab Reporting Parameters block.

7  The Report Fields consist of parameter fields that are associated with the MicroLab Software. Fields can be located in a variety of categories for the user, from Results to Method Parameters. The user should take time to familiarize themselves with the different categories. It is important to note the each type of method has its own Method category and Result category. For example a Qualitative Search method has two categories that are related to it – Hit List and Method Library. Information specific to this type of method and its resultant files will be found here. Whereas more general information would be found simply in Results or Method categories.

8  To add fields to the report, simply click and drag the field desired to the report template page.

a  The field added will only print out the information requested. Since this is in Word, the user may add text at any point in time to identify fields or label material.

b  It is not recommended to use tables other than the predefined tables as this will cause errors in the Report.

9  Predefined Tables for Component Reports and Search Hit Lists have been configured for the user to simply click and drag into the report template.
10 At any time, to preview what the report would look like, select the Preview Rep button located at the bottom of the MicroLab Reporting menu.

a This can also be accomplished through the Perform Merge function.

b It is always best to save the report and run true data against the method where the reports is assigned to determine if the report is showing all values necessary.

11 Once the Report has been edited appropriately, the file should be saved to the report template folder for MicroLab. This folder is typically located in C:\Users\Public\Documents\Agilent\MicroLab \rptTemplates.

a Save the file as .docx file format.

12 There are several report templates that are supplied when the software is installed. They may be edited. However, it is highly recommended that they user save edited report templates as a different file name using the “Save As” function of word, so that the original templates are left intact.
This page is intentionally left blank.
8. Updates and Troubleshooting

Firmware update

Occasionally Agilent will release updates to the firmware (software contained in the FTIR spectrometer). These updates will generally correct bugs that have been noticed by customers, and may expand upon the features that the system can provide. Firmware updates will be provided as Microsoft Windows executables files. These files may be provided directly to the customer, or may be made available in conjunction with an update to the Agilent MicroLab PC application.

Troubleshooting

If you see this error message:

Instrument failed to initialize
Instrument returned error code: -2.
The application will exit; then power-cycle the instrument and restart the application.

Upon loading the software, the spectrometer is not connected to the computer. If using the handheld PC with MicroLab Mobile, verify that the instrument displays a green light on the power button, and verify that the ‘Bluetooth’ communications are turned ‘On’ on the handheld PC. The instrument must be connected for either the MicroLab Mobile or MicroLab PC software. The instrument is not required for MicroLab Lite.
This page is intentionally left blank.
In This Book

The manual describes the following:

- Introduction
- MicroLab Mobile
- MicroLab PC
- MicroLab Quant
- MicroLab with 21 CFR 11
- Measuring Samples
- Reviewing Results
- Updates and Troubleshooting

10/17

0020-410
Issue 7